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SoftPlan 2022 Major Features

DirectX 12

With this release, SoftPlan integrates many new upgrades to its 3D generation capabilities, including the ability to
render the most realistic 3D imagery within SoftPlan to date using the DirectX 12 renderer. Incorporating powerful
path tracing, the DX 12 renderer is a technological leap to unparalleled performance and realism. The combination
of physically based rendering and real-time ray tracing allows SoftPlan to perform lighting calculations that mimic
natural light flow and shadows that result in spectacularly detailed 3D images.

The above image was generated in real-time (instantly) on a DirectX 12 video card.

Metric & Imperial on same drawing

. 7315 When editing a dimension, there is now an
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SoftPlan 2022 Major Features

Nested Drawings & Regions

Nested Regions provide a simple and convenient way to insert
reference drawings and drawing regions into floor plans that often
repeat layouts and other design elements, such as apartment building
plans. Once created and inserted into a drawing, nested regions can

kitchen

then be moved, rotated, and modified to seamlessly join with existing 1) e g
elements on the drawing. Nested Regions also have the option to =y g "a_‘
automatically sync to their sources so that they will update as changes =
are made to the original drawing. With only a few clicks of the mouse == sl

to create and insert Nested Regions, this new feature saves time while
providing the precision needed to design complete, accurate plans.

Stepped Rake Walls

il

SoftPlan’s Wall edit menu now provides the ability to
design complex wall shapes by customizing the tops and
bottoms of walls. In the new Top of Wall and Bottom of

— Wall tabs, walls can be divided into segments and
modified to be stepped, raked, or stepped and raked
" simultaneously by specifying information for each
individual wall segment.

Building Options - Automatic Visibility Conditions
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SoftPlan 2022 introduces user-defined conditions to automatically determine when the visibility of a building option
should be on or off. By specifying these simple AND/OR conditions, you can control the visibility of complex building

Graphic Wall Definition

The new graphic interface within SoftPlan’s
wall definition menu offers a specialized level
of control for creating and modifying the
construction of wall types. Using standard
SoftPlan tools such as Move, Erase, Adjust
Iltem, Edit, and more, you can now modify
materials directly within the wall’s cross section
view which will allow you to visualize the
changes you are making as you define the
wall’'s construction.

[ ] ] [ |
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SoftPlan 2022 Major Features

Brace

SoftPlan 2022 includes the addition of a new command for
drawing braces. Using the two-click drawing process, you can now
quickly add a square brace to a wall or post that automatically
draws at a 45-degree angle. Once added, the brace can be edited
to modify its run, depth, and width.

Add Text to dimensions

Another addition to the Dimension Edit options is

the ability to add custom text to dimensions. Once

the custom text has been entered, the position of
the text can then be specified to replace the
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dimension number or to be added beside or below

7'-6" text added beside

7'-6"

the dimension number.
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Railings

[T 1]
T
I
1]
[
T 1]
1]
1T
Illl’

17

This release completely overhauls SoftPlan's rail configuration by
introducing a new railing assembly menu that allows you to customize
each part of the railing using a table of definable settings and an intuitive
graphic interface. Once configured, these custom railing definitions can
then be further customized to your preferences in the railing Edit menu

and then saved to the System library for future use.

Quick Find Launch

The new Quick Find tool offers the ability to quickly search for
a command to perform or an item to add to the drawing, such
as a particular opening, stair, or symbol. As you begin typing
the name of the command, the Quick Find menu displays a list
of possible selections from which you can click the desired
command to use. Search filters can also be quickly applied to
narrow search results which will help increase drawing speed.

User Information Defined Stamps

Adding to SoftPlan’s vast customization capabilities, this
release introduces User Information Defined Stamps. Used for
printing descriptive text, these custom stamps are easy to
create and add to drawings. Once added to the system or
project, the user-defined stamps are saved for future use and
can be updated at any time.

4 more information at www.softplan.com
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SoftPlan 2022 Major Features

Site Mode Vegetation

The new Vegetation command provides a way to draw grass or other vegetation symbols that
should be grouped together to populate an area on the site plan. The areas that will receive
vegetation can be added as either paint or as a polygon, and the density of the vegetation can be
modified to allow control of the vegetation’s appearance and coverage in 3D.

3D Printing @

E— Exclusive to SoftPlan+ subscribers, this version further expands

& SoftPlan’s extensive 3D export capabilities by adding an option
~'¢M////m to export the 3D model in STL format. SoftPlan’s simple export
process makes it easy to convert 3D models into .stl files that
can then be used for 3D printing.

—

Oculus VR @

SoftPlan’s 3D presentation takes another big step forward

with the incorporation of Oculus VR compatibility. Using an ’ \ i N
Oculus Quest or Quest 2 with an Oculus link, or an Oculus - J A

Rift, SoftPlan+ subscribers can create the experience of = §/ a
stepping into immersive 3D environments they generate from 9 '

their drawings. While navigating 3D models in virtual reality,
what is seen in the Oculus headset is also displayed on the PC screen.

Export Legacy SketchUp Files @

Adding to SoftPlan’s numerous 3D export capabilities, this version enables
SoftPlan+ subscribers to export their 3D models into older versions of SketchUp,
including SketchUp 2017, 2018, 2019, and 2020. This expansion of SoftPlan’s
popular export to SketchUp allows more users to take advantage of the powerful rendering options they need to
create stunning 3D presentations.

Additional SoftPlan+ Manufacturers’ Content includes: @

e

CAMBRIA

laryy KICHLER ﬁ

STERLING]  JBWB-2zer8]  TQTQ  wayfarr
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SoftPlan 2022 Detailed Features

3D
« DirectX 12 rendering support added
« Double left mouse click equals

item Edit when in 3D m
« Light Brightness is measured in s
Lumens ff E-
« Light Temperature is measured ZH‘ N
in Kelvin - =3
« Pause/Resume commands :?
added to 3D generation § e
« “Roughness" and "Metalness" g i
added to the material Edit [ —c
lighting properties. When the ==
material is edited in a PBR .': ——
mode, the PBR properties are j;EE_
shown instead of the S —
traditional diffuse and specular
properties
« PPD Paint Swatches added
« Profiles are continuous when | |
. focm

walls are stacked on top of
each other or when the wall material extends into the
gable end of a roof

« SketchUp export improved

« Skybox Background option added

« Texture on sloped beams follows the slope of the beam

. Time Estimate added — displays the estimated time to
complete a 360-degree photo when Ray Tracing in on

« Walk Mode option added. Turned on, the Camera
moves at eye level while navigating the model which
mimics walking through the house. Turned off, the
Camera moves where it is pointed

Area

« @QAREA_MODEL# stamps display using the Round Area
option

« Color selection added to Create New Area command

« Inside Bearing Edge option added to Reference to Wall

« If two Areas overlap and occupy the same location, Edit
allows each area to reference a different location in the
wall (Exterior Edge vs Outside Bearing Edge)

« Round Area option defaults to On

Beams

« Beam profile is extracted in section

« Finish option added

« HSS (Hollow Steel Section) Beam Type added

. Edited Beam Projections are not affected by the
Cleanup command

« Drawings are prefaced on Beam IDs in a Beam
Schedule if the schedule includes all drawings in the
model stack and Beam IDs are enabled

6  more information at www.softplan.com

Building Options

« 3D Profile items can be drawn directly to a Building
Option

« And/Or Boolean type operator logic added

« Assign Building Options command added to the
right-click of a Selection Set

« Building Option can be renamed directly from the Edit >
Common tab

« Building Options dialog is moveable and dockable

Cabinets

« Additional Painted Cabinet Finishes added

« Countertops print and are shaded by default

« Explode Countertop command added

« Placement of apron (farmer) sinks improved

« Print Pen override added to the Cabinet Run

« Cabinet Schedule fields — new Path and Name fields
available. Path field displays the entire path while
Name field displays the name only

« Toekicks can be completely disabled from an individual
cabinet

« Type Erase — "Plan View Cabinets" now labelled
"Cabinets (Plan)"

« Type Erase —“Elevation View Cabinets" now labelled
"Cabinets (Elevation)"

Ceilings

« Adding a 45-degree Tray Ceiling easier

« Apply Roof Slope command added to right-click. When
selected, the shape of the selected ceiling will
automatically match the shape of the roof above

. Beams are located and referenced by Auto Trace
Ceiling command

« Joist polygons snap to the inside of a Ring Joist

« Ceiling Options accessible directly from the default
Ceiling Mode toolbar

« Strapping extracts in the model displaying in 3D and
Section

« Ceiling Trusses have the same controls as Accent
Trusses

« Vertical Ceiling edges extract the drywall with a
thickness

« Walls under 6' tall, such as those around a stair, will be
ignored when placing a Ceiling via Auto Ceiling

« Hole cutting for recessed lights on sloped ceilings
improved

Details
. Insulation option added to Joist Detail



SoftPlan 2022 Detailed Features

Dimensions Electrical

. A Dimension number that is moved will stay at the new + Lucas Design fan & lights library added
location on subsequent edits — formerly it would reset  « PureEdge Lighting library of lights added

to its original location and have to be moved again « Visible Items added — Wall Exterior !
. Add Text command added — places text beside or Treatment and Wall Interior Treatment
below a "live" Dimension When selected, trim, quoins, & corner
. Auto Dimension of drawings with angled walls improved ~ boards display making it easier to avoid
. Dimension Arc dimensions the Radius of a Circle the trim when placing light switches and
. Filled Circle Arrow style added for outlets
Dimensions & Pointers Elevations & Sections
. Hovering over the direction arrows will preview the . Annotated Elevations & Sections can
result of the Edit display Opening Hinge Direction
. Locating items in close proximity to enlarged . Annotated objects: Roof Pitch, Opening Note and Hinge
Dimension Numbers is more intuitive Direction are added to their own Layer
. Round to Nearest - one foot (1') option added . Floor System Height dimension option added
. Select a Dimension line using Draw Select and the . Show View Page Number option added to System/
Status bar updates with the Shape Dimension and Project/Drawing Options for Elevation/Section Labels

Symbol Dimension options

. Shape Splines or Solid 3D Splines will no longer be
dimensioned « If Block Cut is used on a Selection Set, only the items in

the Selection Set are modified

« Type Erase — All Items separates and labels items as
being assigned to Layers or Building Options

« Type Erase — Ceiling Insulation added

« Type Erase — "Plan View Cabinets" now labelled
"Cabinets (Plan)"

« Type Erase — "Elevation View Cabinets" now labelled
"Cabinets (Elevation)"

« Type Erase — Visible Items Only option added

Erase

. Set Distance Between reference to countertop added

. Stairs work with the Dimension Point command

. The color of the dimension drawn when using the Set
Distance Between function matches the construction
color (red) to match other temporary dimensions

. Units option added to allow Metric and Imperial

Dimensions to be mixed on the same drawing

Wall Thickness dimensions are more difficult to

inadvertently select

Wall Thickness Dimensions are placed outside of

exterior walls

Distance

. If a Slab is visible in drawing mode, it is available to the
Set Distance Between command

. Set Distance Between command ignores wall ends that
participate in a join

Extensions

. Draw Select replicates the Mode, Line Type and Scale
of a source Extension

. Extensions can be added to the edge of the leaf portion
of a Pocket Door

. Extension Lines placed with the Single Extension
command will pull from the closest extendable location
rather than use the System/Project/Drawing setting

Decks . Extensions do a better job of remaining attached to
- Add Left/Right Handrail option added to Edit Ramp wall materials as the walls move in and out of wall joins
dialog . Extensions will not pull from Shape Splines or Solid 3D

- Arrow color changed on a ramp to make it easier to see  Splines
- Deck Stairs and Rails that sit on or above lower decks , QOption added to Cross Section Generation and

will hide the deck lines on the lower decks Elevation Generation to omit the Dimension of the
. Has Overhang option added to Deck Edge edit Floor System Height

. Joist polygons can snap to the inside of a Ring Joist Finishing Options

- Lighted Post Caps added to library « Accent Truss default color added to System/Project
. Position Rail Align option Inside Ring Joist added Options

. Position Rail Align option Outside Ring Joist added

. Radius Edge Solid Surface Deck extracts correctly

. Single Deck Ring Joist references exterior side of a wall

. Wood | Joist Type added

more information at www.softplan.com 7




SoftPlan 2022 Detailed Features

File

« Drawing Modes have individual control of File Overlay

« Drawing Templates Location option added to System
Options

« Export of SketchUp legacy formats SketchUp 2020,
SketchUp 2019, SketchUp 2018, and SketchUp 2017
added for SoftPlan+ subscribers

« Export to REScheck-Web added

« Images are included in DWF file export

« Import results improved when a DWG file has
identically named Layers but different visibility settings
from the target drawing it's being imported to

« Insert of very large image files improved

« Rotated drawings contained in Plan Sets or Multi
Drawings export in the correct orientation

« Search Projects dialog opens when the magnifying
glass icon is selected

« The current selection no longer scrolls after an
operation is performed in the Navigation Window

« Users without SoftPlan+ subscriptions can
alphabetically sort the Projects on the Start Page

Floor System
« Flat Bottom option added to sloped slabs

« Generate Joist Drawing places Joist Hangers on a
separate Layer to facilitate Print Pen control

« If Add Drywall is selected on a Floor System Hole, the
Wallcovering (paint) from Interior Mode extends down
to cover the drywall that surrounds the hole

« If a Slab is visible in Drawing mode it is available to the
Set Distance Between command

« Joist polygons Snap to the inside of Ring Joist & Sill
Plates

Information Stamps

« @QAREA_MODEL# stamps display using the Round Area
option

« @PLAN_SET_NAME stamp added

« @PROJECT_NOTE stamp supports multiple lines of text

« User Information Defined Stamps added

Model
. Open View command added to right-click of Elevation,
Section, Interior Elevation markers

8  more information at www.softplan.com

Interior Elevations
« Clip Distance Depth option added
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« Editing a cabinet on an Interior Elevation now defaults
to the Base Cabinet tab

« Interior Elevation Lines option, separate from Section
Lines, added to Visible Items

- Moving a wall adjusts the size of the Interior Elevation

« Open View command added to right-click of an Interior
Elevation Marker

« Opening Hinge (Door Swing) display added to Interior
Elevations

« Show View Page Number option added to System/
Project/Drawing Options for Elevation/Section Labels

Move

. Block Move selection area around Notes reduced

. Block Move added to Plan Sets

. Center in Room command added to right-click when

applicable

Iltems in a Selection Set can all be rotated by the Make

Parallel command

. Move Wall allows selection of the inner & outer most
visible lines — previously the trace line was selected

. Room Labels are easier to locate

Stairs will "bump" into Walls on a Move making

placement easier

. Text contained within a Symbol is ignored when
centering using the Center in Room or Center Between
Edges commands

Layers

« Layers can be renamed directly from the Active Layer
menu eliminating the need to access via Options

« Layers dialog is moveable and dockable

« Set Layer command added to the right-click of a
Selection Set



Miscellaneous

« Active Action added to right mouse click — useful as a
tiebreaker when multiple items are located within the
locate tolerance

« Adding mathematical calculations to distance entry

fields auto scrolls horizontally when the equation

moves past the end of the edit box

Annotated View (Elevations, Sections,

Interior Elevations) Zoom speed increased

Bitmap highlights added to toolbars

Copy to SoftPlan Clipboard added to right mouse click

Default Visible Items configuration added to Project

Options

Drawing actions are maintained while switching from

one tab to another

Midpoint of total length of Wall, independent of

openings or intersecting walls, added

Opacity added to all Solids in 2D

Option added to save Drawing-level Visibility Options

"up" to the Project level and Project-level Visibility

Options "up" to the System level

Projection Snap indicates the snap type of the source:

triangle, mid point, box, end point...

Quick Launch search command added

Rotate Polygon Edge command added

When entities on a drawing are added to a Selection

Set, the Ribbon menu displays all of the commands

applicable to the items in the selection set

Zoom Extent & Workspace — if objects exist outside of

the workspace the zoom will extend past the

workspace so those objects are displayed

Notes

« Column Totals option added to Schedules

« Double Arrowhead Underline styles added

« Framing Schedule Dimension format defaults can be
changed at Project & Drawing levels in addition to the
System level

« Highlight added to Note Schedules — the currently
selected item in a schedule displays highlighted on the
drawing allowing items to be more quickly located

« Keynote Schedule added to Visible Items

« Pointers not hidden by a Note Mask

« Revision Author Field added to Revisions

« Room Finish Schedules — option for Finish column
added for Baseboard, Tray, Crown Mold & Chair Rail

« Schedule formatting and names of the title and
headers remain unchanged when regenerated

« Word Wrap option added to columns in Schedules

SoftPlan 2022 Detailed Features

Openings

« Baseboard is continuous when Remove & Fill is
enabled for a door

« Barn Door library added

« Corner Face Sliding Door type added

Diamond & Diamond Offset Grille styles added

Extensions can be added to the edge of the leaf portion

of a Pocket Door

Grille placement of radius top windows improved

Header Type Steel | added

Marvin Essential & Elevate Series windows added

Opening IDs properly increment when some Openings

in a project have their IDs disabled

Opening IDs can be assigned to Gable Vents

Windows with Grilles in the top only will form properly if

the thickness has been increased to 1" or more

Opening Header Type column added to Opening

Schedules

Opening Search is enhanced to return openings that

match user-selected criteria such as size and style or

all openings with the same rough opening

Openings can be placed to span between two walls

such as a window with its bottom at the top of one wall

and its top in the bottom of a wall directly above it

(coplanar) (e.g., a window at a landing in a stairwell)

Pediment centers over the opening in the wall when

added to a Pocket Door

Pocket Doors center on the opening hole, not the entire

Pocket Door

« Round and radiused Opening Trim improved so that it
no longer appears segmented

« Show Casement Swing option added to Material

Dimensions > Opening Options dialog

Shutter Height field added — allows the height of the

shutter to be different than the height of the window

Single Panel doors added

« Sliding Doors overlap the individual sections

Sliding Shower Door library added to Interior Openings

The swing on a reversed unit or a single opening with a

non-prehung door reverses correctly

Units display Hinge side when the Elevation column is

included in an Opening Schedule

Window Schedule and Door Schedule commands

added. Window and Door Schedules can be generated

separately from each other

more information at www.softplan.com 9




SoftPlan 2022 Detailed Features

Paint

« Adjacent Paint of the same pattern align vertically and
horizontally

« Improved ability to Paint complicated areas

. 6” vertical & 6” horizontal siding patterns added

Posts

« Draw Brace command added — places a 45-degree
framing member at the specified location

« Helical Pile added

« Pressure Treated Post - No Inset posts added — the
wood post sits on top of rather than formed into the
concrete footing

« Structural Posts default Footing Depth set to 12"

Plan Sets

o 1" =1'default Scale added

Adjust Crop View command added

Align With Another Drawing command added to the
right-click

Annotated Views on a Plan Set page relocate both the
model and the annotations

ARCH E1 added to default sheet size list

Block Move added to Plan Sets

Center on Page command added to right-click

Close All command added

Copy option available when adding a new page to a
Plan Set

Crop View works on rotated Plan Sets

Draw Crop View as a Polygon command added
Drawings can be copied on an existing Plan Set page
Edit and Add Page controls added to the Plan Set
section of the Navigation Window

Export Pages Individually option added to Plan Set PDF
Export

Floating Toolbar on a Plan Set Page can be
customized

Option added to automatically divide the page to aid in
adding 1,2,3 or 4 Drawings to a Plan Set Page

Image files and PDF files can be added directly to Plan
Sets via Drag and Drop

Labels can be automatically added when 3D View
Files are placed on a Plan Set sheet

Multiple Image files can be added at once via Drag
and Drop

Open All command added

Performance improved when moving Site Plans with
large numbers of Shot Points on a Plan Set
Regenerate All on Page command added to the right
click of an existing View

Renaming a Plan Set while the Plans Set is open func-
tions properly

Reset Crop View command added

Use of Invalid Characters is prevented in the Plan Set
name in the Add Plan Set dialog

10 more information at www.softplan.com

Print

« Countertops print and are shaded by default

« Portrait or Landscape option added for each drawing
in the batch

« STL file export added — used by 3D printers

Railings

« Adjust can select Railing Post corners and mid points

« Bottom Post on Stair Position options: As Drawn, Floor
and Bottom available

« Bottom Post For Stair Rail options moved from
Finishing Options > Railing Options to Material
Dimensions > Railing Options

« Each segment of a Railing has independent control
over the presence of the toerail — formerly railing
sections would have to be drawn separately

« Gooseneck transitions added

« Grabrails added to the default deck railing definitions

« Grabrail part type added to the railing definition.
Railings with Grabrails as part of the definition can
include/exclude the definition per railing section

« Half Post not added by default when drawing a rail
that ends at an existing post (column)

« Handrail and Guardrail are separate entries on the
Draw Menu for both Decks and Stairs

« Position option for the placement of the Bottom Post
added to the Railing edit

« Multiple component assemblies can be used to create
Handrails and Toerails

« Options added to Railing Options to control presence
and spacing (Max Post Spacing) of Mid Posts by
default

« Post Height options added — As Defined: value comes
from the Railing Definition; Under Handrail:
automatically adjusts height so the Handrail extends
over the Post; Custom: user override

« Post Style “Two Posts” added — used on outside
corners when the posts are fastened to the outside of
the Ring Joist

« Posts are edited directly. To change a Post’s
properties, select the Post itself for editing, or in the
case of No Post, the end of the Rail

« Rail Alignment option added to Railing Definition —
this allows the user to specify a default rail alignment,
offset and direction

« Railing placement & adjustment on angled Deck Stairs
improved

« Railing part Frame added

« Railing Posts can be linked to a Symbol

« Spindles can be linked to 3D models

« Spindle library added — contains 3D symbols

« Vertical Spindles — separate Width and Thickness
values added allowing boards to be used as Spindles

« Wall Return option added to the end of Railings



Roof

Angled walls — Fit to Roof command improved
Apply Valley
Gable
command
added —the
roof forms a
valley at a
corner between
two gables

Bird Box
improved on
Gable Ends
where Fascia
Boards are different depths on gable end vs. hip side
Compass Direction is factored in when determining the
solar panel optimal facing

Fascias on very low sloped roofs improved

Fascias on Dormers with a radius roof improved

Gable Corners default style settings added

Gable End construction when referencing Walls that
are different heights improved

Gable End option Transition Board added — use to
place a Frieze-like transition board between the top of
the wall and the bottom of the gable

Gutters can be added to Roof Edges that have Shadow
Boards

If the gable end material is set to a profile, the soffit will
extend to the inside on the material

Independent Gable Corners command added — allows
the end style of a Gable Roof to be set differently on
one side versus the other

Intersecting Gable Roofs improved

Multi-Floor Shed Roofs automatically set the high side
roof edge to vertical and intersect

Overlays no longer shared with Multiple Floor Roofs
eliminating any roof cleanups required after working in
other modes

Parapet Roof tools added. The Parapet Walls are
automatically placed on top of the Roof surface inline
with the Walls below

SoftPlan 2022 Detailed Features

« Match Roof Ridge command added — adjusts the slope
of one roof so it intersects the ridge of another roof

« Radiused Roof Holes extract properly in 3D Model

« Raked Fascias with Shadow Boards improved; more
noticeable as the side of the Shadow Board increases

« Rounding on roofs with very shallow Roof Pitches
improved

« Sills can be added to Roof Vents

« Shed Roof Shadow Boards on the high side properly
form corners

« Soffit and Fascia options added to the Gable section of
a Dutch Gable independent of the Hip section

« Soffit Offset option added to move the bottom of the
Soffit above the bottom of the Fascia by the specified
distance

« The size of the font on the automatically generated
Roof Pitch indicators is controlled via the Dimension
character setup

i A Crs

q

« Vent Count option added to the Roof Edge edit
« When the Soffit is Raked, the Frieze Board is moved up
to the wall fascia intersection

reView

« Extents and Page Size fields added to the Import PDF
Shapes dialog. These provide information to aid in
selecting the appropriate scale when importing the PDF

« Improved quality when a PDF contains a cropped view
of a drawing that contains an image

« Portrait or Landscape option added for each drawing in
the batch

« Text on a Layer that is set to Fade will Print faded

« Watermark option added to PDF export

11
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SoftPlan 2022 Detailed Features

Roof Framing SoftList
. Accent Truss Bottom Deflection option added « A SoftList report exported to Excel (*.xIsx) opens
correctly in Google Sheets

- Board Type check box controls added to the Group
Deck material dialog for decking board component

« Beam ID value can be listed on a SoftList Report

« Copy Existing command added when creating a new
Lumber Table

« Crown Mold quantity on a raked wall corrected

« Cut List Customize Lumber Lengths option added to
each Material

« deck_board_type variable added

« decking_board & parting_board constants added

« Deck Constants Builtup and Wood removed

« Deck Toerail Group recognizes the selected profile
Library

« Grid Lines added to the Report Layout

« Groups that are collapsible added to Material
Configuration — this simplifies managing the large list
of materials

« If there are no errors, the Error Window will not display

« joist_spacing variable added to Floor, Ceiling and
Landing joist groups

« Page Breaks can be inserted into Reports

« Report changes display in the Output Window

« Room location of a material can be listed on the
SoftList Report

« Two decimal point accuracy added to Excel Export of

« Accent Truss King Post Projection option added

« Auto Stick Frame command adds framing members to
the Hip Return portion of a gable roof

« No Tails added to Top Chord Style option

« Horizontal style option added to Gable End Truss

« Roof Holes cut roofs framed with Purlins fields that contain percentages
« Roofs with Holes properly frame with staggered rafters . SoftList Configuration is a single dialog — combines the
« Stick Framing of stacked bullnose improved settings for Symbol Libraries, Cabinet Libraries, Lumber
. Tables, Help, External Price Tables, and Library
Site )
Categories

« Edit Color setting is on the Site Object tab instead of
the Site Line tab

« Edit of a radiused Site Line displays the length on the
arc

« Large Site Plans with Grade Lines extract faster to 3D

« Rotate to Ortho command added

« Site Poly changes duplicate with Repeat Edit drawings

+ Size option added to Geo-location Point « Undo & Redo commands added to editing of saved

« Vegetation command added — used to cover areas with  rgports
multiple occurrences of symbols (e.g., grass for lawns
or trees for wooded areas)

« SoftList Reports added to a Plan Set page
automatically regenerate as the assembled drawings in
the model change

« Symbols added to Highlight Entities command

« Symbol ID changes made to the Symbols in the System
Library update the Symbols contained in existing

« Variables material_profile, profile_spacing &
vertical_profile added
Stairs « *.xlsx files (Excel) added as a source for External Price
. Default Railing Types added for each Stair Type — Tables
Options > Material Dimensions > Stair Options
« Duplicating or Draw Selecting a stair no longer adds
railings or reverses the stair
« Stairs will "bump" into Walls on a Move making
placement easier
« The Dimension Between command has access to the
Stair lines in an overlay file
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SoftPlan 2022 Detailed Features

Symbols Walls |2 Hour Fire Wall (Party Wal)
« The Draw Symbol dialog opens in the same spotitwas . 2 Hour Fire Wall (Part Wall) type e—————
last closed within a drawing session added to default Extended Wall il
« 2D Residential Elevator symbols added list ﬂ

« Move To Top and Remove From Top (if the symbol had . Adjust Wall Surface to Cover i
previously been moved to the top) options added to the  Floor command improved ﬂ
right-click of a Symbol on the Draw Symbol dialog « Auto Dimension of drawings with
« Rock library and Symbols added angled walls improved
« A symbol can be redefined replacing the existing - Continuous Footing is added
instances with the revised definition between Wall Footings and Post
Footings
Wall Framing « Graphic User Interface added to
« 3D Framing Visible Line view can be saved as a Wall Definitions setup
SoftPlan Drawing « Top of Wall & Bottom of Wall
« Add Plate Above Header option added options tabs added. These are

used to manipulate a single wall

to have multiple heights, steps,

slopes and offsets

Corner Boards extend to meet

the Soffit by default when

applied to a gable wall under a

shed roof

Cover Floor options added when

a Wall is placed on top of a Deck

— used in screened porch

applications

If the outside material of the old

wall and the new wall have a

« Add Stud on Flat command added — places a new Stud  matching join group (siding A to
parallel to the wall siding A or Siding B) when using

the Change Wall command, the

End Treatment will remain and

not be reset

QOutside Corner Only option

added to Material Dimensions >

Trim Options

Stud-LVL material added < —

<Outside | Inside >

Wall Definition dialog sizing

improved on UHD Monitors

Wall Definition — if a material is changed to another

material of a similar type, the values for Inside Visible,

Inside Pen, Inside Color, Outside Visible, Outside Pen,

Outside Color, Texture & Shading Pen, Texture Color,

Shading Color and Linestyle will not change

« Extend Jack Above Header option added Wall Joins improved

« Framing is added over the opening if there is no header « Wall material HSS, hollow steel section, added

« Lines (edges) between coplanar framing members « Stone - Faux material added
display « Wall materials retain their Fixed setting after a Wall
« Opening Header type Steel | added Definition is Exported and then Imported
« Steel Studs extract as "C" sections in Framing Mode « Safeguards put in to protect Wall Definitions as they
and 3D Framing are introduced into a drawing via Merge or Copy/Paste.
« Wall Panel drawings generate and print shaded making . Visible Properties filter added — makes it easier to
it easier to read isolate a specific property for editing
« Wall Strapping is extracted in 3D Framing Views « Wall Definition plan preview added to and Drawing

Options menus
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SoftPlan+ cloud drive and services
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SoftPlan+ is a subscription-based service that offers complimentary upgrades, enhanced technical support, access
to exclusive content, the complete training library, and the SoftPlan+ online cloud drive that makes sharing projects
across multiple locations easier.

Cloud Sharing

SoftPlan+ saves the most recent copies of projects to the SoftPlan+
cloud drive. With a SoftPlan key and a high-speed internet
connection, a different system installed with SoftPlan can continue
work on a shared project.

SoftPlan reView extensions also allow documents to be published for
customer viewing, including 2D vector drawings and rendered
panoramic views. Customers can also make notes on the vector
drawings and any changes appear automatically the next time the
project is opened.

Current SoftPlan Version

Never pay for an upgrade again. SoftPlan+ subscribers have no-cost
access to the latest version SoftPlan has to offer.

Toll Free Technical Support Number

Reach SoftPlan’s technical support team with the SoftPlan+ toll free
number to receive personalized assistance.

Integrated Support Tickets

SoftPlan+ includes the ability to submit support tickets directly
through the SoftPlan+ interface. SoftPlan support staff can review a
project’s files and provide the appropriate feedback to address the
issue.

Command and Control Support

With permission, SoftPlan+ support technicians have the ability to
take control of a SoftPlan+ subscriber’'s computer for advanced assistance.

Command and control support sessions are initiated at the discretion of the technician.
All SoftPlan+ features require a high-speed internet connection.

BORALR
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SoftPlan+ cloud drive and services

Customer Interaction

Always keep customers up to date by publishing 2D
plans and 3D models that they can view from a PC,
android, or iOS device of their choice.

reView

All reView functionality is available through SoftPlan+
including the authoring of reView & PDF files.

|:‘ I [4)
o & O

Panorama Views

Automatically generate panoramic views from y
predefined points to create a fully immersive 3D experience on PC, iPad, iPhone, or android devices.

iOS and android Support

Using a free viewer app, recipients of published SoftPlan files can mark up and add notes to 2D drawings or take
virtual tours of a house in full, panoramic 3D, all from the convenience of their iOS or android device.

Online Training Content

SoftPlan+ provides full online access to the complete training library with over 160 step-by-step tutorials. New
content that is added to the training library becomes immediately available to SoftPlan+ subscribers.

360° Photo on Facebook and Web Pages

A SoftPlan+ subscription offers the ability to generate 360 ° photos within the 3D model
and publish them directly to a Facebook page or website.

360° photos are interactive images that can be panned and explored by anyone faCEbOOk
viewing them.

Premium Content

SoftPlan+ subscribers have access to additional content that is stored on the SoftPlan+ cloud server. SoftPlan may
augment these offerings at any time.
Enhanced Libraries

SoftPlan+ symbol libraries include new libraries of Kitchen Accessories, Beds, Stools, Lights, Office
Furniture, Range Hoods, Chaise Interior Décor, Tables, Dressers, Wardrobes, Entertainment Consoles,
Credenzas, Sectionals, Benches, Ottomans, Vehicles, Bathroom Furniture, and much more.

Enhanced Textures

SoftPlan+ texture libraries include enhanced entries and manufacturer offerings including some from the
manufacturers listed below.

Product names, logos, brands and other trademarks referred to within SoftPlan Systems, Inc.’s products, services and within this
brochure are the property of their respective trademark holders.

@ BRUZO [— ZENN-ARR
— (O caesarstone ﬂ —_— yfafr‘
daltile
Miele) AVONITE Y DLB Room&Board
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